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Introduction 1 

 

 

The purpose of this manual is to assist users with connecting the timing console, results 
computer, and displays together to get the most out of a rodeo timing system.  

 

Figure 1illustrates the Daktronics drawing 
numbering system. Daktronics identifies 
individual engineering drawing by their 
drawing number (7087-P08A-69945 in the 
example), which is located in the lower 
right corner of the drawing. This manual 
refers to drawings by their last set of 
numbers and the letter preceding them. 
The example would be Drawing A-69945. 
 
Reference drawings are grouped and inserted in alphanumeric order in  
Appendix A: Reference Drawings. 

 
Additionally, any drawing referenced within a particular subsection is listed at the beginning 
of that subsection in the following manner:  
 

Reference Drawings:  

Segmentation, 7 Seg Bar Digit ................................................................. Drawing A-69945 
 

Daktronics identifies manuals by their engineering document (ED or DD) number, which is 
located on the cover page of the manual. For example, this manual would be referred to as 
DD1660229. 
 

With questions regarding the safety, installation, operation or service of these systems, 
contact Daktronics. For more information on Daktronics Customer Service refer to Section 5. 
 

Important Safeguards: 

 
1. Read and understand these instructions before making a connection. 
2. Do not drop the control console or allow it to get wet. 
3. Be sure the display is properly grounded with an earth-ground electrode at the display 

location. 
4. Disconnect power to the display when it is not in use. 
5. Disconnect power when servicing the display. 
6. Do not modify the display structure or attach any panels or coverings to the display 

without the written consent of Daktronics, Inc. 
 
Daktronics builds rodeo timing equipment for long life and require little maintenance. 
However, from time to time, certain display components will have to be replaced. The 
Replacement Parts List in Section 4 provides the names and part numbers of components 
that may require replacement during the life of this display. 
 
Following the Replacement Parts List is an explanation of Daktronics Exchange and Repair & 
Return Programs. Refer to these instructions if replacing or repairing any timing component.  

 
 

Figure 1: Daktronics Drawing Label 
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This manual includes the following sections: 

 

 Section 1: Provides an overview of the product, product safety information and 

labeling and numbering descriptions 

 Section 2: Explains the connection methods to a Venus® 1500 controller 

 Section 3: Explains the connection methods to a Venus® 7000 controller 

 Section 4: Explains how to set up display sequences for both types of controller 

 Section 5:  Offers details about who to contact for help and information on 

Daktronics Exchange and Repair &Return Programs 

 Appendix A: Contains all drawings referenced in this manual 

 Appendix B: Contains the Daktronics Warranty and Limitation of Liability 

 

This manual contains the following software conventions and terminology: 
 

Bold Indicates an item that requires direct action, such as clicking, pressing, 
selecting or formatting. 

Italics Indicates onscreen text or labels that are not clickable. 

Bold Italics Used to reference items within the manual, such as figures or sections, as 
well as other documents and important notes.  

[X] Represents a keyboard key that needs to be pressed. 

“Quotes” Text or commands that may be typed. Quotes also indicate folder names. 

Click Press and release the left mouse button. 

Double-click Press and release the left mouse button twice. 

Right-click Press and release the right mouse button. 

Select Highlight or mark, such as by placing a check mark  in a nearby box; 
clicking will not necessarily perform an action. 

> Followed by (ex. File > Open). 

 

Many software options can be accessed with the keyboard as well as the mouse. Where 

applicable, both mouse and keyboard actions are given to perform a command. Many screen 

buttons have labels that have a letter underlined. Press the key on the keyboard that 

correlates with the underlined letter to activate that particular button. To activate secondary 

buttons, press the underlined key while holding [Shift]. To activate menu bar items from the 

keyboard, press the underlined key while holding [Alt].
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This section explains the setup of the OmniSport® 2000 timing console and DakStats® 3000 Rodeo 

software to a Venus® 1500 version 3 controlled display with an M2 or M3 controller. 

The preferred method for communications between the computer with Venus 1500 software and an 

M2 or M3 controlled display is Ethernet. The Ethernet communications can be wired, fiber or wireless 

(Ethernet Bridge). This section assumes that communications have already been established between 

the Venus 1500 computer and the sign by making the physical connections as well as the appropriate 

network configurations such as the subnets and IP addresses. 

Real-Time Data (RTD) from the DakStats 3000 Rodeo software is sent to the display via the Venus 

1500 Real Time application. RTD from the OmniSport 2000 can be sent directly to the display’s 

current loop input or through a network via the Daktronics Communication Server (DCS) software. 

For displays with copper wire Ethernet connectivity, refer to Drawing B-326247.  For displays with 

fiber Ethernet connectivity, refer to Drawing B-299772.  For displays using a wireless Ethernet Bridge, 

refer to Drawing B-326248.  

Riser Diagram; Rodeo............................................................................ Drawing B-299772 
Riser Diagram; Wired Rodeo ................................................................. Drawing B-326247 

Riser Diagram; Wireless Rodeo ............................................................. Drawing B-326248 

 

The OmniSport 2000 uses photocells, pushbuttons, judges consoles and the rodeo interface, to 

time and score rodeo events for display on numeric scoreboards and matrix displays, and can 

also send that data to the DakStats 3000 Rodeo software. This section focuses on connecting 

the OmniSport to the matrix display and to DakStats 3000 Rodeo software. 

1. Connect a straight through 9-pin male to 9-pin female serial cable (Daktronics part 

number W-1267) from the Results Port (J6) on the OmniSport 2000 console to an 

available COM port on the computer with the DakStats 3000 Rodeo software (this 

may be the same computer running Venus 1500). 

 

Note: Use the following setup if the OmniSport 2000 console is sending RTD directly 

to the M2 or M3 controller in the display:  

 

Use a 9-pin to ¼" stereo phono cable (Daktronics part number 0A-1240-0032) to 

connect the 9-pin end to the RTD Port (J5) on the OmniSport and plug the ¼" 

connector into a 2" x 4" J-box (0A-1091-0227) as shown on Drawing B-326247, or 

connect the ¼" connector into the current loop to fiber converter (0A-1196-0131) as 

shown on Drawing B-299772. Either connection will run into the display controller. 
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The DakStats 3000 Rodeo software has an input configured to receive times and scores from 

the OmniSport 2000 and a separate output to send RTD to Venus 1500 Real Time. Refer to the 

DakStats 3000 Rodeo Software Installation & Operation Manual (ED-14946) for more 

information on setting up this program.  

 

DakStats 3000 Rodeo software is typically loaded onto the same computer as the Venus 1500 

software. The first question is whether DCS is being used. DCS is only used if the OmniSport 

2000 console is not connected directly to the M2 or M3 controller in the display.  

 

 If the OmniSport 2000 console is connected directly to the display, then the DakStats 

3000 Rodeo input will be configured to the COM port that the Results Port (J6) is 

connected to.  

 If the OmniSport 2000 console will send RTD over the network via DCS, the DakStats 

3000 Rodeo software input is configured to receive timer data via a UDP socket. 

 

1. In the DakStats 3000 Rodeo software, go to Configure > Input/Output. 

2. In the Input/Output Configuration window (Figure 2), double-click the first empty 

box under the Configure Ports section. 

 

 

 

 

 

 

 

 
Figure 2: Input/Output Configuration 
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3. In the DLStreams Wizard window (Figure 3), enter the following settings: 

 

 If DCS is not used –  

Type:  COM Port 

Name:  “Timer” 

(click Com Settings) 

Port:  COM1 

Baud:  19200 

Data Bits:  8 

Parity:  None 

 

 If DCS is used – 

Type: UDP/IP 

Name: “Timer” 

(click Udp Settings) 

Udp Port: “3002” 

Output: Broadcast 

 

 

Note:  Actual COM port numbers may vary depending on which ports are available 

on the results computer. 

 

Click Finish to save the port settings. 

 

4. Under the INPUT: Timer section, click on the first empty box in the Name column and 

type in “Timer”.  Next click under the Port column, and select Timer from the list. 

5. Double-click the next empty box under the Configure Ports section. 

6. Back in the DLStreams Wizard window (Figure 3), enter the following settings: 

 

Type: UDP/IP 

Name: “Results”  

(click Udp Settings)  

Udp Port: “20000” 

Output: Broadcast 

 

Click Finish to save the port settings. 

 

7. Under the OUTPUT: Rodeo In Progress (RIP) RTD section, click on the first empty box 

in the Name column and type in “Results”.  Next click under the Port column, and 

select Results from the list. Then select Serial under the Type column. 

 

The difference between Serial and Network is the amount of data being sent across.  

In most cases, whether the connection between the DakStats 3000 Rodeo software 

and Venus 1500 Real Time is serial or network, select serial. Doing so limits the 

amount of data and also eliminates timing delays because there is less data to send. 

 

 

 

 

 

 
Figure 3: DLStreams Wizard 
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8. The settings in the Input/Output Configuration window should look like Figure 4 

 (this window will look like Figure 5 if using DCS): 

 

 

 
Figure 4: Input/Output Settings  

 
Figure 5: Input/Output Settings (using DCS) 
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The Venus 1500 Real Time application relays the data from timing console and the DakStats 

3000 Rodeo software to the internal RTD buffer of the display. This application must remain 

open at all times to keep outputting RTD. 

 

Note: If the Venus 1500 Shell does not have the Venus 1500 Real Time icon (Figure 6), first 

make sure that the Venus 1500 Real Time software key (Daktronics part number 0A-1147-

0011) is plugged into a USB port on the computer. If it is plugged in and the icon is still not 

showing up, the driver may need to be re-installed. Please contact Customer Support with 

any questions.  

 

 

 

1. Click the Venus 1500 Real Time icon (Figure 6).  

2. In the Venus 1500 Real Time main window (Figure 7), double-click on Input 2  

(Input 1 is reserved for data coming directly from the timing console).  

 

3. In the Input Properties window (Figure 8), click Configure.  

Figure 6: Venus 1500 Real Time Icon 

 
Figure 7: Venus 1500 Real Time 

 
Figure 8: Input Properties 
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4. In the Configure Input window (Figure 9):  

a. Select UDP Port.  

b. Click OK. 

 

5. In the UDP Port window (Figure 10): 

a. Set the Udp Port to “20000”. 

b. Click OK. 

 

6. Back on the Input Properties window (Figure 8), click ITF. 

7. In the Select An Input Template window (Figure 11), click the drop-down list and select 

Browse.  

 
Figure 9: Configure Input 

 
Figure 10: UDP Port Settings 
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8. Navigate to “C:ProgramFiles\Daktronics\Common\Input\Templates” and select 

“Rodeo In Progress (Serial).itf”.  

 

Note: If this file does not show up on the list, it will need to be copied from the 

“C:\Program Files\Daktronics\DsRodeo” directory to “C:\Program 

Files\Daktronics\Common\Input Templates”. 

 

9. Click OK. 

10. Back on the Input Properties window (Figure 8), click Select Displays. Choose the 

display that the data will be sent to and click the arrow to move it into the Authorized 

for RTD Input column, and then click Close.  

 

The primary OmniSport 2000 console will be connected via current loop communications 

directly to TB1 pins 2 and 6 on the M2 or M3 controller in the display (M2 or M3 varies 

depending on the display model).  

1. Using the M2Config application, verify the settings for ports 1-4. On the 

Configuration tab, click on the Communications folder, and then Ports. If there is a 

Debug port setup, make sure to delete it, as it will interfere with sending RTD. 

Port 1  

Type:  Direct 

Baud Rate: (19,200 for Galaxy Displays) 

  (115,200 for Galaxy Pro Displays) 

Number: 1 

Protocol: Venus 1500 

 

Port 2  

Type:  TCP/IP 

Number: 3001 

Protocol: Venus 1500 

 

 
Figure 11: Select An Input Template 
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Port 3  

Type:  UDP/IP 

Number: 3002 

Protocol: Daktronics RTD 

 

Port 4  

Type:  Direct 

Number: 2 

Protocol: Daktronics RTD 

Baud Rate:  19,200 

 

2. Connect the cable from the OmniSport 2000 RTD Port (J5) or J-box to the display. 

3. Test the connection from the OmniSport 2000 to the display by running an RTD 

sequence that shows the running time from the console. Refer to Section 4.3 on how 

to make Venus 1500 sequences. 

4. If nothing shows up on the display: 

 Is the sequence playing created by using a custom ITF? 

 Are the ports set up correctly for the display (see Step 3 above)? 

 Is it connected to the RTD Port (J5) on timing console? 

 Are the settings in the OmniSport 2000 console correct? 

 Does the wire terminate correctly in the J-box and on the display? 

 If the OmniSport 2000 console is connected via Ethernet, verify that everything is 

plugged in and set to the correct TCP/IP addresses. 

 

Daktronics Communication Server (DCS) is an additional software program that will need to 

be installed on the same Venus and DakStats 3000 Rodeo computer. DCS is used to receive 

data from the Results Port (J6) on the OmniSport 2000 console and broadcast the signal out 

over a network connection to the DakStats 3000 Rodeo software as well as to the M2 or M3 

controller within the matrix display.  

 

Using DCS is especially useful with wireless Ethernet communications because it eliminates a 

second dedicated cable from the RTD Port (J5) on the OmniSport 2000 console to the M2 or 

M3 display controller.  
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DCS will have two ports set up: an input 

and an output. DCS will take the data in 

from the OmniSport serially, and output it 

on a network port to the matrix display 

and the DakStats 3000 Rodeo software.  

 
1. Open DCS and click the Ports tab 

on the left side of the window.  
2. In the Daktronics Communications 

Server – Ports window (Figure 12), 
double-click on an empty port to 
set up the following two ports:  
 
Port 1 (Figure 13) 
 

Name: “Omni” 
Type: Serial Port  
Port: COM1  
Baud: 19200 
Data Bits: 8  
Parity: None  
Input Template:  
OS2-RODEO.itf 

 
Note: COM port numbers may 
vary based on the actual port(s) 
available on the computer. 
 
Port 2 (Figure 14) 
 

Name: “DakStats/Galaxy” 
Type: UDP/IP Socket 
Port: 3002 
Input Template:  
Rodeo In Progress (Serial).ITF 

 

Note: If this file does not show up 
on the list, it will need to be copied 
from the “C:\Program 
Files\Daktronics\DsRodeo” 
directory to “C:\Program 
Files\Daktronics\Common\Input 
Templates”. 

 
 
 
 
 
 
 
 
 
 
 
 

 
 

Figure 12: Daktronics Communications Server- Ports 

 
 

Figure 13: Port 1 Configuration 

 
 

Figure 14: Port 2 Configuration 
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3. After configuring the ports, click on the Data Flow tab on the left side of the DCS 
window. Draw the connection between the two newly created ports, with the RX of 
Port 1 going to the TX of Port 2 (Figure 15).  

 
 Figure 15: Daktronics Communication Server- Data Flow 
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This section explains the setup of the OmniSport® 2000 timing console and DakStats® 3000 Rodeo 

software to a Venus® 7000 controlled display.  

 

The components needed are a Venus 7000 controller, DakStats 3000 Rodeo software, an OmniSport 

2000 console, and a Daktronics video display. 

 

Optional components include a Push Button Interface, Judges Consoles, Photocells, Daktronics 

Communications Server (DCS) software, a Microsoft Loopback Adapter, and a network hub (for 

network communication method). 
 

System Riser, Rodeo, Pro Star .............................................................. Drawing B-320179 

 

The OmniSport 2000 uses photocells, pushbuttons, judges consoles and the rodeo interface, to 

time and score rodeo events for display on numeric scoreboards and matrix displays, and can 

also send that data to DakStats 3000 Rodeo software. This section focuses on connecting the 

OmniSport to the video display and to DakStats 3000 Rodeo software.  

1. Connect a straight through 9-pin male to 9-pin female serial cable (W-1267) from the 

Results Port (J6) on the OmniSport 2000 console to an available COM port on the 

computer with the DakStats 3000 Rodeo software. 

 

2. Connect a straight through 9-pin male to 9-pin female serial cable (Daktronics part 

number W-1267) from the RTD Port (J5) on the OmniSport 2000 console to an 

available COM port on the Venus 7000 computer. 

 

Note: Typically the connection from the OmniSport 2000 to the RTD input in the 

Venus 7000 computer is serial. In special cases, the signal may be routed through 

Daktronics Communication Server (DCS) and sent over a UDP/IP socket instead. 

Refer to Section 2.5 for more information about configuring DCS. 

 

The DakStats 3000 Rodeo software needs an input configured to receive times and scores 

from the OmniSport 2000 console and a separate output to send RTD to the Venus 7000. Refer 

to the DakStats 3000 Rodeo Software Installation & Operation Manual (ED-14946) for more 

information on setting up this program. 

 

The DakStats 3000 Rodeo software and the Venus 7000 software typically communicate via a 

network connection. In rare cases, a serial connection may be used. When using network 

communications, the Venus 7000 computer and the DakStats 3000 Rodeo computer must be 

networked together on the same Subnet/IP range. If the DakStats 3000 Rodeo software is 

installed on the Venus 7000 computer and it is not plugged into a router, a Microsoft 

Loopback Adapter must be installed to allow network communication between the two 

programs. Visit http://support.microsoft.com/kb/839013 for more information about 

installing the loopback adapter. 

http://support.microsoft.com/kb/839013
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 If the OmniSport 2000 console is connected to the DakStats 3000 Rodeo computer 

serially, then the DakStats 3000 Rodeo input will be configured to the COM port that 

the Results Port (J6) is connected to.  

 If the OmniSport 2000 console will send RTD over the network via DCS, the DakStats 

3000 Rodeo software input is configured to receive timer data from the UDP socket 

set in DCS. Refer to Section 2.5 for more information about configuring DCS.  

 

1. In the DakStats 3000 Rodeo software, go to Configure > Input/Output. 

2. In the Input/Output Configuration window (Figure 16), double-click the first empty 

box under the Configure Ports section. 

 

3. In the DLStreams Wizard window (Figure 17), enter the following settings: 

 

 If DCS is not used –  

Type:  COM Port 

Name:  “Timer” 

(click Com Settings) 

Port:  COM 1 

Baud:  19200 

Data Bits:  8 

Parity:  None 

 

 If DCS is used – 

Type: UDP/IP 

Name: “Timer”  

(click Udp Settings)  

Udp Port: “3002” 

Output: Broadcast 

 

 
Figure 16: Input/Output Configuration 

 
Figure 17: DLStreams Wizard 
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Note:  Actual COM port numbers may vary depending on which ports are available 

on the DakStats 3000 Rodeo computer. 

 

Click Finish to save the port settings. 

 

4. Under the INPUT: Timer section, click on the first empty box in the Name column and 

type in “Timer”.  Next click under the Port column, and select Timer from the list. 

5. Double-click the next empty box under the Configure Ports section. 

6. Back in the DLStreams Wizard window (Figure 17), enter the following settings: 

 

Type: UDP/IP 

Name: “Results”  

(click Udp Settings)  

Udp Port: “20000” 

Output: Broadcast 

 

Click Finish to save the port settings. 

 

7. Under the OUTPUT: Rodeo In Progress (RIP) RTD section, click on the first empty box 

in the Name column and type in “Results”.  Next click under the Port column, and 

select Results from the list. Then select Serial under the Type column. 

 

The difference between Serial and Network is the amount of data being sent.  In most 

cases, whether the connection between the DakStats 3000 Rodeo software and Venus 

7000 is physically a serial or network, select Serial as the Type. Doing so limits the 

amount of data and also eliminates delays because there is less data to send. 

 

8. The settings in the Input/Output Configuration window should look like Figure 18  

(this window will look like Figure 19 when using DCS): 

 
Figure 18: Input/Output Settings  
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Two RTD ports will need to be set up in the Venus 7000 software to receive information from 

both the OmniSport 2000 console and DakStats 3000 Rodeo software. Typically RTD is sent 

from DakStats 3000 Rodeo software to the Venus 7000 over Ethernet. In rare cases, serial 

ports may be used instead. 

 

 If the OmniSport 2000 console is connected to the Venus 7000 computer via a serial 

connection, then the RTD input will be configured to the COM port that the RTD 

Port (J5) is connected to.  

 

 If the OmniSport 2000 console will send RTD over the network via DCS, the RTD 

input is configured to receive timer data from the UDP socket set in DCS. Refer to 

Section 2.5 for more information about configuring DCS. 

 

 

 
Figure 19: Input/Output Settings (Using DCS) 
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1. On the Venus 7000 Shell, click 

Configure, and then click on the 

RTD Inputs tab. 

2. Double-click Input 1 and set up the 

port as follows:  

 

Port 1  

 

If DCS is not used (Figure 20) - 

Name: “OmniSport” 

Source Type: COM PORT  

Baud Rate: 19200 

Source: COM1  

Parity: None 

Protocol: Enhanced  

Data Bits: 8  

Size: “1024” 

Default Input Template:  

OS2-RODEO.itf 

 

Note: COM port numbers may vary 

based on the actual port(s) available on the computer. 

 

If DCS is used (Figure 21) - 

Name: “OmniSport” 

Source Type: UDP/IP SOCKET  

Source: “3002” 

Protocol: Enhanced  

Size: “1024” 

Default Input Template:  

OS2-RODEO.itf 

 

Click OK when finished. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
Figure 20: Edit RTD Input1 

 
Figure 21: Edit RTD Input1 (DCS Method) 
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3. Double-click Input 2 and set up the port as follows:  

 

Port 2 (Figure 22) 

 

Name: “DakStats Rodeo” 

Source Type: UDP/IP SOCKET  

Source: “20000” 

Protocol: Enhanced 

Size: “4096” 

Default Input Template:  

Rodeo in Progress (Serial).itf 

 

Note: If this file does not show 

up on the list, it will need to be 

copied from the “C:\Program 

Files\Daktronics\DsRodeo” 

directory to “C:\V7000”. 

 

Click OK when finished. 

 
 
 

 
Figure 22: Edit RTD Input2 
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An Input Template File (ITF) consists of multiple fields that select the start position and 

length of pieces of RTD in a data stream. To access and save these files, go to 

http://dakfiles.daktronics.com/downloads/Sports_Products/ITFs/.  

Then right-click “OS2-Rodeo.itf”, then click Save Target As and save as type Input Template 

in the following location: 

 Venus 1500: “C:\Program Files\Daktronics\Common\Input Templates” 

 Venus 7000: “C:\V7000” 

 

Note: Refer to the Venus 7000 Controller Operator’s Manual (ED-14551) for more 
information on setting up RTD display sequences. 
 

1. Open the V7 Sequence Designer and create a new sequence for the appropriate sign  

(File > New). 

2. Go to Frame > Insert > Data Frame.  

3. In the Frame Properties window (Figure 23), 

select the Data Field Parameters tab. Make 

sure the Field Type is set to RTD then select a 

previously created Input, either for the 

OmniSport 2000 console or for the DakStats 

3000 Rodeo software computer.  

4. Under Field Name, select from the list of 

available information. Use the Row and Col 

numbers (or click on the sequence) to adjust 

the position of the data field. 

5. To add another data field, simply 

increment Field in the top left corner 

of the Frame Properties window.  

 

Figure 24 shows a complete example 

of a Venus 7000 rodeo sequence. 

6. After creating all of the required 

fields for the data frame, click OK. 

The sequence now contains two 

frames: the original Graphic Frame 

and the new Data Frame; the first 

Graphic Frame must be deleted. 

 

Figure 23: Frame Properties 

 

Figure 24: Sample Venus 7000 Rodeo Sequence 

http://dakfiles.daktronics.com/downloads/Sports_Products/ITFs/
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Go to Frame > Delete (or press [Ctrl + Del]). Then select 

the range 1 to 1 (Figure 25). Click Delete Range and then 

click Close. There should now only be one frame, the 

Data Frame and the RTD fields it contains.  

 

Note: It is possible to create multiple frames that can be 

automatically selected from within the DakStats 3000 

Rodeo software. Refer to Appendix B for more 

information. 

7. Click the preview button  (or press [F5]). As long as the input source is powered on 

and in operation, the correct data should show up in the proper location on the sequence. 

Make any adjustments to the RTD fields or input connections as needed. 

8. Save the sequence.  

 

Note: Refer to the Venus 1500 Software Version 3 Operation Manual (ED-13530) for more 
information on setting up RTD display sequences. 
 

1. Begin by opening the V1500 Message Studio from the V1500 shell. Select File > New and 

select the sign for the new RTD sequence.  

2. Next, a Graphic Frame must be added. To do this, select menu item Frame >Add > 

Graphic. Graphic Frames are preferred for RTD because they allow positioning of the RTD 

boxes exactly where the user desires.  

Note: In the Sample Text field, the user can enter the text that will help to identify the 

information to show on the frame. By default, the data fields show S’s as sample text.  

The Justify option buttons will override the justification settings in the ITF file. This 

feature is available only when inserting an RTD field in a graphic frame for display with 

Version 3 controllers. 

3. To add an RTD field, go to Data Fields > 

Real Time Data, or select the 

RTD icon from the left hand pane.  

 

Click anywhere in the Graphic Frame and 

an RTD Field Properties window will open.  

4. At the top, click the drop-down list box 

and select a previously configured input. 

Alternately, select Custom ITF and then 

the browse button. Search for and select 

the correct ITF for rodeo and click OK.  

 

 

 

 

Figure 25: Delete Frame 

 

Figure 26: Add RTD Field  
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After selecting an input or Custom 

ITF, a list of available data from the 

port will populate (Figure 26). Once 

the desired field type and 

parameters are chosen, click Add to 

set the field to the frame. Then click 

Close and change the style and 

alignment of the field boxes inside 

the frame. The user can now 

preview the frame but only as long 

as the input source is powered on 

and in operation. Refer to Figure 27 

for a sample rodeo sequence.  

5. On the right there should be a story board with two frames, a blank Text Frame and a 

second Graphic Frame with RTD information. The first frame must be deleted in order for 

the sequence to display correctly. At the story board, right click on the blank Text Frame 

> Delete Frame(s). There should only be one frame left: the Graphic Frame with RTD 

information. 

6. The frame duration (of frames 14-32) should also be changed from a couple seconds to a 

couple hours; this ensures the running time will not skip. In the lower left hand corner of 

the frame, see where it says Frame Duration, change the Min to Hr. 

7. To save the message: 

a. Open the File menu and select Save. 

b. In the Save Message dialog box, click on the plus sign next to the display type to 

open the library containing the folders.  

c. Select the folder where the message will be saved in and type in the name, for 

example “OS_2000_Rodeo” (Figure 28). 

d. Click Save.

 

Figure 27: Sample Venus 1500 Rodeo Sequence  

 

Figure 28: Save Message 
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 Exchange and Repair & 
Return Programs

To serve customers’ repair and maintenance needs, Daktronics offers both an Exchange Program and 

a Repair & Return Program. 

 

Daktronics unique Exchange Program is a quick service for replacing key parts in need of 

repair. If a part requires repair or replacement, Daktronics sends the customer a replacement 

and the customer sends the defective part to Daktronics. This decreases display downtime. 

Before contacting Daktronics, identify these important part numbers: 

 

Timer Serial Number:____________________________________  

Contract Number:_______________________________________  

Date Installed: _________________________________________ 

Daktronics Customer ID Number:__________________________ 

 

To participate in the Exchange Program, follow these steps. 

 

1. Call Daktronics Customer Service: 

Schools (primary through community/junior colleges), religious 

organizations, municipal clubs, and community centers 

877-605-1115 

Universities and professional sporting events, live events for auditoriums, 

and arenas 

866-343-6018 

2. When the new exchange part is received, mail the old part to Daktronics. 

3. If the replacement part fixes the problem, send in the problem part which is being 

replaced. 

a. Package the old part in the same shipping materials in which the replacement 

part arrived. 

b. Fill out and attach the enclosed UPS shipping document. 

c. Ship the part to Daktronics. In most circumstances, the replacement part will be 

invoiced at the time it is shipped. 

4. A charge will be made for the replacement part immediately, unless a qualifying 

service agreement is in place. In most circumstances, the replacement part will be 

invoiced at the time it is shipped. 

5. If the replacement part does not solve the problem, return the part within 30 working 

days or the full purchase price will be charged. 
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If, after the exchange is made the equipment is still defective, please contact Customer 

Service immediately. Daktronics expects immediate return of an exchange part if it does not 

solve the problem. The company also reserves the right to refuse parts that have been 

damaged due to acts of nature or causes other than normal wear and tear. 

 

For items not subject to exchange, Daktronics offers a Repair & Return Program. To send a 

part for repair, follow these steps: 

1. Call or fax Daktronics Customer Service:  

Refer to the appropriate market number in the chart listed on the previous page. 

2. Receive a Return Materials Authorization (RMA) number before shipping.  

This expedites repair of the part. 

3. Package and pad the item carefully to prevent damage during shipment. 

Electronic components, such as printed circuit boards, should be placed in an 

antistatic bag before boxing. Daktronics does not recommend packing peanuts  

in packaging. 

4. Enclose: 

 Contact name 

 Address 

 Phone number 

 The RMA number 

 A clear description of symptoms 

Daktronics Customer Service 

PO Box 5128 

331 32nd Ave 

Brookings, SD 57006 

The Daktronics Warranty and Limitation of Liability is located in Appendix C. The Warranty 

is independent of Extended Service agreements and is the authority in matters of service, 

repair, and display operation.  
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Riser Diagram; Rodeo ............................................................................................... Drawing B-299772 
System Riser, Rodeo, Pro Star ................................................................................. Drawing B-320179 
Riser Diagram; Wired Rodeo ..................................................................................... Drawing B-326247 

Riser Diagram; Wireless Rodeo ................................................................................ Drawing B-326248 
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The DakStats® 3000 Rodeo Results Default Display Profile 
 
The DakStats® 3000 Rodeo software uses function keys to send and select which data will be 
displayed by Daktronics display controllers. The software allows the user to edit and create different 
display profiles. All of the examples below are using the default display profile. 
 
In order for the display controller to match up data with the correct template, the RTD sequence 
MUST be created with exactly 32 frames in a precise order. A good example of the integration of this 
software with the display controller is a Barrel Racing event: 
 

1. The operator would press [F7] to display the current Go Round Leader and current 
competitor.  Since the results software knows that a new contestant was selected, it sends the 
correct data and a select frame command for frame 18.  Frame 18 has the time field for the 
current contestant configured for the Timer RTD input. 

2. As soon as the ride is complete and the software sees the final time from the timer, it 
automatically sends the new data and sends a select frame command for frame 19.  Now the 
display is showing the official time from the Results software RTD input. 

  
Depending on the current event, pressing a function key will display different information. The 
following tables summarize the default function key settings for each event found in the DakStats 
3000 Rodeo software. This document is meant as a reference while creating RTD sequences.   

 
 

Bareback 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Run Time Yes Yes Yes 20  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Score 

Yes Yes Yes 17  

F7 Current Go 
Round 

Yes Yes Yes 20  

F8 Current 
Average  

Yes Yes Yes 24  

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   
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Saddle Bronc 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Run Time Yes Yes Yes 20  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Score 

Yes Yes Yes 17  

F7 Current Go 
Round 

Yes Yes Yes 20  

F8 Current 
Average  

Yes Yes Yes 24  

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   

 
 

 

Bull Riding 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Run Time Yes Yes Yes 20  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Score 

Yes Yes Yes 17  

F7 Current Go 
Round 

Yes Yes Yes 20  

F8 Current 
Average  

Yes Yes Yes 24  

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   
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Bull Fighting 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Run Time Yes Yes Yes 20  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Score 

Yes Yes Yes 17  

F7 Current Go 
Round 

Yes Yes Yes 20  

F8 Current 
Average  

Yes Yes Yes 24  

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   

 
 

 

Goat Tying 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Logo No No No 2  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Time 

Yes No Yes 19 18 

F7 Current Go 
Round 

Yes No Yes 22 21 

F8 Current 
Average  

Yes No Yes 24 23 

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   
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Team Roping 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Logo No No No 2  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 16  

F6 Current 
Time 

Yes No Yes 19 18 

F7 Current Go 
Round 

Yes No Yes 28 27 

F8 Current 
Average  

Yes No Yes 30 29 

F9 Go Round 
Leaders 

No No No 31  

F10 Average 
Leaders 

No No No 32  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   

 
 

 

Team Penning 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Logo No No No 2  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 16  

F6 Current 
Time 

Yes No Yes 19 18 

F7 Current Go 
Round 

Yes No Yes 28 27 

F8 Current 
Average  

Yes No Yes 30 29 

F9 Go Round 
Leaders 

No No No 31  

F10 Average 
Leaders 

No No No 32  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   
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Break Away 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Logo No No No 2  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Time 

Yes No Yes 19 18 

F7 Current Go 
Round 

Yes No Yes 22 21 

F8 Current 
Average  

Yes No Yes 24 23 

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   

 
 

 

Steer Wrestling 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Logo No No No 2  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Time 

Yes No Yes 19 18 

F7 Current Go 
Round 

Yes No Yes 22 21 

F8 Current 
Average  

Yes No Yes 24 23 

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   
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Tie Down Roping 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Logo No No No 2  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Time 

Yes No Yes 19 18 

F7 Current Go 
Round 

Yes No Yes 22 21 

F8 Current 
Average  

Yes No Yes 24 23 

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   

 
 

 

Barrel Racing 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Logo No No No 2  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Time 

Yes No Yes 19 18 

F7 Current Go 
Round 

Yes No Yes 22 21 

F8 Current 
Average  

Yes No Yes 24 23 

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   
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Steer Roping 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Logo No No No 2  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Time 

Yes No Yes 19 18 

F7 Current Go 
Round 

Yes No Yes 22 21 

F8 Current 
Average  

Yes No Yes 24 23 

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   

 
 

 

Custom Score Event 
 

Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Run Time Yes Yes Yes 20  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Score 

Yes Yes Yes 17  

F7 Current Go 
Round 

Yes Yes Yes 20  

F8 Current 
Average  

Yes Yes Yes 24  

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   
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Custom Time Event 
 
Function 
Key  

Description 
 

Update 
Display 

Update 
Manually 

Update 
Announcer 

Frame # of 
Result 
Updating 

Frame # 
of Timer 
Updating 

F2 Logo No No No 2  

F3 Announcer No No Yes   

F4 Event Text No No No 14  

F5 Current 
Profile 

Yes No Yes 15  

F6 Current 
Time 

Yes No Yes 19 18 

F7 Current Go 
Round 

Yes No Yes 22 21 

F8 Current 
Average  

Yes No Yes 24 23 

F9 Go Round 
Leaders 

No No No 25  

F10 Average 
Leaders 

No No No 26  

F11 Page 
Backward 

No No No   

F12 Page 
Forward 

No No No   
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The following list is a summary of the 32 frames and their function.  All data is coming from the 
results RTD input except where running time noted, that comes from the timer RTD input. 
 

Frame # Description 

1 Blank 

2 Sponsor Logo 

3 Tie Down Roping Logo 

4 Steer Wrestling Logo 

5 Team Roping Logo 

6 Barrel Racing Logo 

7 Bareback Riding Logo 

8 Saddle Bronc Riding Logo 

9 Bull Riding Logo 

10 Steer Roping Logo 

11 Bull Fighting Logo 

12 Break Away Roping Logo 

13 Goat Tying Logo 

14 Rodeo Display Information (rodeo name, location, and date) 

15 Current Contestant Information (name, hometown, earnings, and others) 

16 Current Team Information (name, hometown of the header and the healer) 

17 Current Contestant and their score.  (Individual scored event) 

18 Current Contestant with running time.  (Individual timed event) 

19 Current Contestant with time.  (Individual timed event) 

20 Go Round Leader with score and Current Contestant with running time and score.  
(Individual scored event) 

21 Go Round Leader with time and Current Contestant with running time.   
(Individual timed event) 

22 Go Round Leader with time and Current Contestant with time.   
(Individual timed event) 

23 Avg Leader with time and Current Contestant with need-for-lead and running time.  
(Individual timed event) 

24 Avg Leader with time and Current Contestant with need-for-lead and time.  
(Individual timed event) 

25 Go-round Leader Board for Individual Events. 

26 Average Leader Board for Individual Events. 

27 Go Round Leader with time and Current Team with running time.  (Team timed event) 

28 Go Round Leader with time and Current Team with time.  (Team timed event) 

29 Avg Leader with time and Current Team with need-for-lead and running time.   
(Team timed event) 

30 Avg Leader with time and Current Team with need-for-lead and time.   
(Team timed event) 

31 Go-round Leader Board for Team Events. 

32 Average Leader Board for Team Events. 
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